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LastPass 

Password Storage 
System In The Cloud 

By Jerry Naditch 
BRCS Vice-President 

Jerry Naditch, BRCS‟s Vice-President will 

discuss LastPass: a password manager that 

makes web browsing easier and more secure.   

First, he'll tell you why you want and need to 

protect your online identity.  Then, he'll describe 

LastPass, which is not a separate program, per 

se, but is integrated into your web browsers.   

LastPass, which is free, will greatly enhance 

your web browsing experience when going to 

sites that require user names and passwords. 

December 15, 2010 
Door Prize 

The December door prize, for members in good 

standing, will be a Toshiba XP Laptop.. 
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Paul Merlin 

Arthur Oluwek 

Philip Pantano 

Gene & Leona Paw-
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As of December 2010 
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Milton Sherman 
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Florence Tonelson 

Arthur L. Walter 

Stanley Warshaw 

Oscar Young 

Membership News & Views 
New Members 
October / November 2010 

Muriel Arnold 

Benjamin Berges 

Ed Bernard 

Evelyn Brodkin 

Torrey Everett 

Fred Greenberg 

Bob Herman 

Frances Holden 

Alan Pastor 

Charles Williams 

Expired Memberships 
As of November 2010 

Raymond Berlin 

Evelyn Chernetz 

Martin Harris 

John W Lange 

Stewart Rahr 

Marvin Silveston 

Expired Memberships 
As of December 2010 

(May not reflect renewals received after Nov. 17, 2010) 

Philip Ansted 

Nicolas Arena 

Walter Bayer 

Joseph Bendersky 

Victor Blumenthal 

Alfred Eriv 

William Fingerett 

Milton M Ganberg 

A J Hendler 

Joshua & Harriet Kalin 

Elaine Pare 

Sherman Pessin 

Martin Shack 

Robert Tanzer 

Martin Weinberg 

Joel Whitman 

Isabel Yarnall 

Judith Yellen 

See Page 5 for more Membership News & Views 
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We had another great general meeting in November. 

Congratulations to our door prize winners (see the 

brcs.org site, or page 5 of this newsletter). 

Paul Nappo gave the main presentation on the subject 

of backing up your computer. 

Upcoming Election The Board of Directors 

It is that time again, a Nominating Committee has 

been selected, as the Board of Directors will have to be 

elected at the January 2011 annual meeting. 

At this time, the current members of the Board will be 

standing for re-election, with the exception of Jerry 

Bartzoff. Jerry will still be around but, has decided to 

leave the Board 

If you are interested in becoming a member of the 

Board, contact the committee. Nominations will also be 

accepted from the floor, at the annual meeting.  

January 19, 2011 Presentation 

Joseph R. Scondotto, Assistant Vice President/ Store 

Manager, of TD Bank will be giving a presentation, and 

demo, of online banking to the BRCS members. (See his 

bio on page 8 of this newsletter.) 

More information will be coming in the January, 2011, 

edition of Boca Bits. 

This should prove to be a very interesting general 

meeting presentation, and it is something that has been 

requested repeatedly in the past.  

Thank you Greg Glenn for taking the time to set this 

up for us. 

Volunteer Positions 

We can always use volunteers to help out. You do not 

have to be a board member to volunteer.  

SOME OF THE OPEN POSITIONS 

Program Coordinator 

Public Relations 

Facilities Coordinator 

SIG Coordinator 

Assistant Editor 

There are many more than these that are not formally 

named, and any assistance is appreciated. Remember this 

is your organization, not that of the Board, and we can 

not continue to provide what you are looking for without 

help. 

Contact myself or any of the other Board members, if 

interested in helping out. 

General Meeting Presentations 

A lot of you belong to user groups within your 

community, or other user groups, as well as belonging to 

BRCS. 

If you saw a great presentation at your community, or 

group, that you think would be of interest to others in 

BRCS, please contact the Board and provide the contact 

information, so that others can take advantage of the 

opportunity of seeing the presentation. 

Once again, this is your organization, help us provide 

quality information. 

Steve Costello 

December 2010 

Steve Costello 

Boca Raton Computer Society 
President’s Message 
By Steve Costello, President, BRCS 

Communications from the President of Boca Raton Computer 
Society, regarding important issues and information. 

www.brcs.org
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December 15, 2010 Door Prize 
The main door prize for the December 2010 general meeting will be an XP Toshiba Laptop, for a lucky BRCS 

Member, in good standing.  

It is always possible that there will be one of Richard Miller's famous brown bag prizes as well. 

More Membership News & Views 
November 2010 Door Prize Winners 

The door prizes for the November general meeting consisted of a netbook and one of Richard Miller's famous 

brown bags. The lucky winners were Stanley (Stan) Roth for the netbook, and Arthur Walter for the brown bag, which 

turned out to be a USB Card Reader.  

Congratulations to them both, photos of them accepting their prizes are shown below, with the prize winners on the 

left and BRCS President Steve Costello on the right. 

HP Netbook Winner — Stanly (Stan) Roth Brown Bag (USB Card Reader) Winner — Arthur Walter 
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Introduction 

Is it any wonder no real work gets done any more? 

Since the advent of the personal computer, the workforce 

in the world has been in a constant learning mode. Early 

in the game there were many competing programs to buy. 

Some had a steep learning curve, others were fairly easy 

to conquer.  

In business, you either got the concept of a spreadsheet 

or you didn„t. One way or the other the number crunching 

software became a dominant player in the office environ-

ment.  

The same held true for word processing. Apple had the 

inside track on graphics, but folks that is also based on 

numbers whether you can see it or not. Don„t be fooled. 

Computers only do one thing, they turn on and off little 

switches which make up what you see on your screen. 

And they do it with two numbers, 0 and 1. Off is 0, On is 

1.  

Admittedly it is a bit more complicated than that, num-

ber combinations which tell the computer what those two 

switches will turn on or off, but the basis of all computing 

is number handling. 

Software Updates / New Releases 

Since the time of the first personal computers, there 

has hardly been a gap between the last software update 

and the newest release. 

Those developers who had a good product that was 

supposed to last forever found themselves quickly out of 

business, buried in the onslaught of Microsoft and IBM 

sales techniques.  

Just as Mt. St. Helens buried a good chunk of real es-

tate, so has Microsoft buried the competition in personal 

computer software. Funny, both Microsoft and Mt. St. 

Helens are located in Washington state. Anyway, there 

seems to be no end to the product finagling designed to 

make users think they are getting something new. 

RETRAINING 

But here is the problem. With each new version of both 

software and operating systems, endless retraining is 

needed to get the individual or workforce up to speed and 

to actually be productive.  

This provides work for the trainers, but of course the 

trainees never arrive at the productive stage because there 

is always a newer incarnation of the same old tired soft-

ware, requiring the cycle to begin all over again.  

For government entities this is no problem since very 

little beneficial work gets done there anyway. But for 

other businesses, a thinking person might find it confus-

ing that any corporation, large or small, could be profit-

able in the above scenario.  

I don„t know to what extent the business world is re-

sisting the pressure to upgrade and update, but obviously 

if one large company chooses to do so, many others must 

follow suit. Monkey see, monkey do. 

Computer Use 

The day has long passed since the novelty of owning a 

desktop computer, either in an office or at home, was ex-

citing. Few people have opted to do much more than use 

email on their home machines.  

(Continued on page 9) 

It’s Crystal Ball Time Again 
By Elizabeth B. Wright, Member, Computer Club of  Oklahoma City 

October 2010 issue, CCOKC eMonitor 

www.ccok.org 

wright599new(at)sbcglobal.net 

http://www.ccok.org
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Tips Syndicated From Sharon Parq Associates 
http://www.sharonparq.com/ 
A little bit about Sharon Parq Associates, directly from their website: 

"Sharon Parq Associates (SPA) is a publisher of high-quality information 
on the Internet. Our flagship site, Tips.Net, provides a gateway to many 
other sites focused on providing information in a variety of topic areas." 

Microsoft Word: Inserting the Template Name in Your Document 

Microsoft Excel: Using the CONCATENATE Worksheet Function 

Every Word document has a template attached to it. 

Depending on your version of Word, this template 

defines things such as your menus, toolbars, macros, and 

styles (among other things). If you do not explicitly 

attach a template, then Word uses the Normal template. 

The name of the template file attached to your 

document can be inserted into your document and 

updated automatically.  

To do this, follow these steps: 

1. Position the insertion point where you want the 

template file name to appear. 

2. Display the Field dialog box. (In Word 2007 or 

Word 2010 display the Insert tab of the ribbon and 

then choose Quick Parts | Fields from the Text 

group. If you are using an older version of Word, 

choose Field from the Insert menu.) 

3. In the Categories list, choose Document 

Information. 

4. In the Field Names list choose Template. 

5. Click on OK to close the dialog box and insert your 

field. 

Copyright © 2010 by Sharon Parq Associates, Inc. 

Reprinted by permission. Thousands of free Microsoft 

Word tips can be found online at http://word.tips.net. 

Excel provides a function called CONCATENATE 

which can be used to combine the contents of several 

cells, or even to combine cell contents with other text. 

For instance, let‟s say you wanted to add together the 

contents of cells A3 and B3, separate them by a space, 

and have the result appear in cell C3. All you need to do 

is put the following formula in cell C3: 

Primarily, the CONCATENATE function is used for 

compatibility with other spreadsheet programs. 

You can just as easily use the ampersand (&) operator 

to combine text values using a formula. For instance, the 

following is equivalent to the example of 

CONCATENATE shown above: 

Copyright © 2010 by Sharon Parq Associates, Inc. 

Reprinted by permission. Thousands of free Microsoft 

Excel tips can be found online at http://excel.tips.net.  

The Field dialog box. 

=CONCATENATE(A3," ",B3) 

=A3 & " " & B3 

http://www.sharonparq.com
http://word.tips.net
http://excel.tips.net
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Hasta la Vista 
Repairing Corrupted Thumbnail Images In Vista 
by Lee Reynolds, Member BRCS 

I'm told the literal meaning of "hasta la vista" in Spanish is "until the seeing." Or 
maybe a more adequate translation is "see you later."  

But, in this column, I'm using that phrase to invite you to take a look at Microsoft's 
latest version of Windows: Vista. 

Thumbnail images can sometimes get corrupted.  

In Windows XP, you needed to delete a hidden file 

called thumbs. db from the folder in which "thumbnail 

view" of the images in it was enabled, and then redisplay 

of the folder with the thumbnail view enabled would 

regenerate this cache.  

In Windows Vista, there is no thumbs. db file; it has 

been replaced by others. The file has been replaced by a 

number of "thumbcache_xxxx. db" files which are now 

located within a user's profile at  

\Users\<account name\AppData\Local\ 

Microsoft\Windows\Explorer  

The "xxxx" in the above file names are digits which 

seem to correspond to the size of the icons: 32, 96, 256, 

and 1024 on my system. There is also an index file called 

thumbcache_idx. db  

The folder AppData is a hidden folder and will only be 

visible in a user's profile if he has turned on the option 

for Show hidden files and folders on the View tab of 

Folder Options in Control Panel. 

The Disk Cleanup Wizard included with Vista may be 

used to delete these thumbnails. Then the next time the 

folder containing the images with thumbnails is opened 

and viewed, the thumbcache files will be recreated, 

hopefully without corruption.  

There are programs available for viewing the 

information stored in the Vista thumbcache files, one 

being called dm Thumbs, which has a Frequently 

Answered Questions webpage about thumbcache: 

http://www.dmthumbs.com/faq_thumbcache.html 

* * * * *  

Bio of  Joseph R. Scondotto, Presenter for January 19, 2011 

Joseph R. Scondotto, Assistant Vice President and Store Manager for the Boca Camino office, joined TD Bank in 

March of 2010. Joseph is responsible for business development, consumer lending,  and community relations in the 

Boca Raton market, as well as the overall supervision and the professional growth of his staff of 9 employees.  

He is an active participant in many local charitable organizations including Junior Achievement and the Tri-County 

Humane Society. He is currently serving on the Board of Directors for Letip‟s Boca Raton Chapter, a professional 

networking group. 

Joseph has worked in the financial services industry since 1986. Prior to joining TD Bank, he was  a branch 

manager for Regions Bank in Boca Raton.  

Joseph has been a resident of Palm Beach County for the past 15 years and currently resides in Delray Beach with 

his wife Esther. He was born and raised in Brooklyn, New York where he graduated from Xaverian High School.  He 

received a Bachelor‟s degree from Pace University in Finance. He was employed by Citigroup for 14 years working 

mostly as a senior financial analyst.   

http://www.dmthumbs.com/faq_thumbcache.html
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Small offices either had to make do with older soft-

ware and machines or face non-profitability in the up-

grade race. A few have been able to continue business as 

usual without changing with each new version, but the 

lack of support for older systems must be placing a heavy 

burden on such establishments. 

Wi-Fi Users 

Go to any bookstore or restaurant with wi-fi and you 

will see many people with their laptops doing what ap-

pears to be research, homework or business transactions. 

Are they upgrading their machines and software at every 

turn?  

These people often take up prime seating (case in 

point: a booth for four people which becomes a virtual 

private office) and conduct their affairs via the free inter-

net access. Some even go so far as to talk to what I as-

sume are customers/clients, either by cell phone or phone 

access via the computer.  

Can the restaurants and bookstores make enough 

money from these customers to continue providing free 

offices for them?? For the people taking advantage of the 

free spaces and services, perhaps it„s the only way they 

can make any kind of living. After all, if they had to pay 

the internet bill themselves or rent office space they al-

most surely could not be competitive.  

While these customers may buy a drink, or possibly 

even some food, the time they spend taking up space 

seems unreasonably long to me. But I suppose the busi-

ness owners know what they are doing. Or do they? On a 

very recent internet news blurb there was reference to 

this very problem.  

As some of the coffeehouse/ bookstores/ deli cafes 

face lower profits, will they begin to see this phenome-

non as a good thing gone sour? 

Back To Upgrades 

Back to the subject of endless upgrades, I can under-

stand hardware upgrades. But how can any of this super-

fluous software revision possibly be good for consumers?  

Since the really big companies utilize very specialized 

software and mainframe hardware which requires a far 

different kind of tech support, when does the upgrade 

cycle for the rest of us come to an end? 

Conclusion 

Are we in the fourth quarter in a tied game, users 0, 

developers 0?  

Laptop computers use the same software as our nearly 

obsolete desktop systems, so what is the picture?  

There is no overtime or sudden death playoff in this 

game. No winners, only losers.  

Some are saying we are at the end of the road for per-

sonal computers.  

Young people seem to want nothing bigger than some-

thing they can hold in their hands. 

Or could I be totally wrong? Is there a whole new 

world of technology about to be opened up to us.  

Who will lead the way?  

This article has been obtained from Articles2Go with 

permission to reprint by non-profit, or other user groups 

with credit given to the author, the publication and the 

user group. A copy of this newsletter has been sent to the 

author, or editor. 

* * * * *  

(Crystal Ball Time Again Continued from page 6) 

"There are two ways of constructing a software design; one way is to make it so simple that 

there are obviously no deficiencies, and the other way is to make it so complicated that there 

are no obvious deficiencies. The first method is far more difficult. "  
 
C.A.R. (TONY) HOARE, English computer scientist at Oxford. 

24NOV10—http://www.giga-usa.com/quotes/authors/c_a_hoare_a001.htm  

http://www.giga-usa.com/quotes/authors/c_a_hoare_a001.htm
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I hope you find something of interest to yourself in 

this issue, and that, if there is something of particular 

interest you wish to see in a future issue, you contact me, 

and I will see what I can find for you. 

Lee Reynolds Articles 

Lee has provided us with the latest installments of 

Hasta La Vista and  The Seventh Son of Windows. 

These should help you to keep up with these latest 

Windows operating systems. 

Sharon Parq Associates Tips 

This month the syndication of Microsoft Word and 

Microsoft Excel tips, from Sharon Parq Associates, 

continues.  

The latest set of tips start on page 7 of this issue: 

Word -  Inserting the Template Name in Your 

Document 

Excel -  Using the CONCATENATE Worksheet 

Function 

If you like these tips and would like to see a lot more 

similar tips, please check out their http://www.tips.net/ 

site. It contains these and many other topics. 

Articles2Go 

It’s Crystal Ball Time Again 

Is This Thing On? – Book Review  

PDF Files in iTunes - For Syncing on Apple Devices 

The above are the titles of articles provided by Judy 

Taylour, via Articles2Go, for reprinting.  

SIG News 

I have started a place for the SIG leaders to present a 

little information about their SIG. 

This month there is information regarding:  

 Digital Photography 

Moderated by Jerry Dinerman 

 Paint Shop Pro And Then Some 

Moderated by Stan Glazer 

 Windows XP/Vista/Win7  

Moderated by Richard Miller 

 Freeware / Open Source 

Moderated by Steve Costello. 

 Hardware/Software 

Moderated by "Captain Ray" Sollberger  

Comments Solicited 

I am always trying to find good, relevant, informative 

content, so need your feedback. 

Please send your comments and / or suggestions to: 

editor@brcs.org 

Please include a subject line, that begins with: 

Bits Comment 

This will enable me to quickly distinguish it from 

other emails. 

Editor’s Note 
By Steve Costello 

This is where the editor communicates with you, the reader. 

Here you will find information regarding upcoming changes in format 
and / or content. 

http://www.tips.net
mailto:editor@brcs.org
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Introduction 

I finally read one of those books for Dummies (the one 

for Seniors). Actually I only read parts of it. I definitely 

have trouble with the title. I know it says a manual for the 

rest of us - and it definitely reads like a manual - but self 

talk is important and I‟m not a dummy.  

It was part of my due diligence for reviewing Abby 

Stokes‟ new beginners‟ book, Is This Thing On? There 

really is no comparison. A manual is a manual.  

About Is This Thing On? 

Abby‟s book reads like a chat between friends. It is 

also generic - this helps the how-to instruction teach con-

cepts and builds confidence in venturing into new areas.  

Abby also has a website (www.abbyandme.com) that 

she encourages her readers to use. There are tutorials, 

practice areas, and website links, as well as part of the 

first chapter of her book. That Abby has hands on experi-

ence in teaching computers to seniors is very evident.  

She compares using a computer with using other com-

plex machines (like a car). You don‟t need to understand 

how they work to use them. If you know someone who is 

new to computers, this is the book they need.  

There are now three copies in our library system. So-

noma has one and it was checked out within an hour of 

being placed on one of the new book shelves. 

TARGET AUDIENCE 

One of the best things about Abby‟s book Is This 

Thing On? is that she doesn‟t try to have something for 

everyone. She has a target audience (adult first-time com-

puter users) and writes for them.  

Reading this book felt more like a chat with a friend 

than an instruction manual. 

MS WINDOWS AND MAC 

The other thing that sets this book apart is that it is the 

most generic computer book I have read. Abby gives di-

rections for both Windows and Mac operating systems 

because the computer you buy will have one or the other. 

There are pros and cons for both systems. 

COMPUTER BUYING ADVICE 

Her advice on buying a computer is to try several 

models with an idea of what you want and a “Test Drive 

Form” to have filled out on the day(s) you take your test 

drives. She also suggests you check with your support 

system. You will get better help if the person you call on 

a Sunday afternoon has the same operating system. 

ADAPTABILITY 

Adaptability is a major theme in Abby‟s book. 

To help readers be flexible with what they find, she 

uses different examples for the same computer task. In 

each one the steps or sections have the same numbers.  

She explains that there are different versions and the 

reader‟s computer screen may not look exactly like her 

examples.  

She also makes clear that things on the Internet (i.e. 

websites or browsers) often look different after they are 

updated. 

VARIETY 

Variety is always highlighted.  

When discussing the Internet, Abby gives instructions 

for Firefox, Explorer, and Safari.  

(Continued on page 14) 

Is This Thing On? – Book Review  
By Beth Pickering, President,  

Sonoma Valley Computer Group, CA 

November 2010 issue SVCUG newsletter 

Bethpick (at) emailx.net 

www.vom.com/svcg 

http://www.abbyandme.com
http://www.vom.com/svcg
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The Seventh Son of  Windows 
Windows Media Player 
by Lee Reynolds, Member BRCS 

Windows 7 has arrived.   
Let's explore the features of this newest incarnation of Microsoft Windows... 

Introduction 

Windows 7 features a new version of Windows Media 

Player, version 12, which has a number of improvements 

over the version 11 available in Windows XP and 

Windows Vista: 

 There is a lightweight version (Now Playing 

mode vs. Library mode) 

 When you right click the Taskbar icon, you get a 

jump list 

 You can add media from your network by 

clicking Organize -> Manage Library 

 Hovering on any song in a playlist allows 

playing of a 15-second preview of the song 

 It supports more media formats, such as AAC 

audio, and both Xvid and DivX video 

 You can stream media to other PCs in your 

HomeGroup ("play to") 

 You can browse ITunes libraries and play most 

selections (those that are not DRM-protected) 

The new version of Windows Media Player 

completely separates the task of library management 

from what's currently playing, with two different modes 

of operation: Now Playing view, and Library view.  

Library view contains all the library manipulation 

features that should be familiar from Windows Media 

Player 11.  

Now Playing view contains the current playlist, 

visualizations, and videos.  

The Jump List will give you a list of frequently or 

recently played musical pieces or videos, as well as tasks 

such as: Resume Last Playlist, Play All Music, Unpin this 

program from Taskbar, and Close Window. 

* * * * *  
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MEETING OF 11/11/10 

A meeting on Veterans Day called for special remem-

brance, in the form of a giant decorated sheet cake, with 

flags, and red, white & blue butter cream. How could we 

possibly have a meeting without honoring our Veterans 

with a few choice words and a small token of apprecia-

tion? 

PRESENTATION 

George Brucks had been at our club a few years back 

and he returned to show us how much he has refined his 

presentation. This time he showed us things on a personal 

level. A new found relative with a net worth of 6 billion 

dollars, and an ancestor who was worthy of having her 

portrait painted by the famous artist John Sargent. 

George was well prepared for this demonstration of Ge-

nealogy. Prior to the meeting we forwarded the names of 

over a dozen members to him, including the names of their 

parents and any other information thought to be helpful. 

Although none of these names could be located in the re-

search that he did, it gave our members a good overview 

on how and where to do the research and how to insert 

information in recommended programs – i.e. “Brother‟s 

Keeper”/ 

Two handouts, listing the many websites associated 

with Genealogy, were made available to every member. 

One was given out at the meeting and the other forwarded 

to them by Email. Because of George‟s layback manner, 

patience, knowledge of the subject and his dry sense of 

humor, the presentation was thoroughly enjoyed. 

UPCOMING 

We are also looking forward to seeing Pamela Tabak at 

our 12/9 meeting, when she will show us some “Tips and 

Tricks” which should be enjoyed by a membership with a 

wide range of skill levels. 

Lou Strumlauf, President 

www.huntingtonlakescomputer.com 

* * * * *  

Huntington Lakes Computer Club 
Lou Strumlauf, President 

PDF Files in iTunes - For 
Syncing on Apple Devices 
By Ernie Cox, Jr., member of  the 

Computer Club of  Green Valley, AZ 

November 2010 issue, Green Bytes 

http://gvcc.apcug.org 

ecoxjr (at) cox.net 

There is an easy way to get PDF files into iTunes for 

syncing to your iOS device (iPad, iPhone or iPod 

Touch).  

The iBooks apps can then view the PDF files, as long 

as you have iTunes 9.2 and iOS 4.  

Create an alias of iTunes.app and drag it to your 

userfolder/Library/PDF Services. (Create the folder if it 

does not already exist.)  

You can rename the alias, iTunes PDF files.  

The next time you are viewing a document you would 

like to read later on your iOS 4 device, go to:  

File > Click on Print 

Click the PDF Button on the bottom left corner of the 

Print dialog box, 

Choose iTunes from the list.  

The iTunes app will then launch and receive the PDF.  

The next time you sync your device, the document 

will be synced as well.  

This article has been obtained from Articles2Go with 

permission to reprint by non-profit, or other user groups 

with credit given to the author, the publication and the 

user group. A copy of this newsletter has been sent to the 

author, or editor. 

* * * * *  

http://www.huntingtonlakescomputer.com
http://gvcc.apcug.org
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In email the examples are from Yahoo, Gmail, and 

AOL. Search engines used are Google, Yahoo, and Ask.  

The section on surfing the Internet has examples of 

different websites for areas like shopping, auctions, 

travel, and banking.  

There are also multiple pictures of hardware such as 

computers, mouse devices, printers, scanners, cell 

phones, PDAs and iPhones. 

WEBSITE 

There is also a hand holding website – 

www.abbyandme.com - with more information, tutorials, 

and links.  

Throughout the book, Abby encourages her readers to 

visit her website and to try their new skills out with her. 

Conclusion 

It was very clear to me that Abby has worked with and 

understands the audience she writes for.  

She includes comments and questions (with the an-

swers) from her students.  

She encourages the beginner to look on using the com-

puter as an adventure and not to worry about the mistakes 

they will be making.  

She advises learning in stages and taking breaks. 

Is This Thing On? would make an excellent gift for 

anyone who is interested in learning computers.  

After saying how good this book is for newbies, I will 

have to admit I picked up some pointers myself.  

I also had a veteran computer using friend buy a copy 

of this book for herself after looking at mine. 

List price: $15.95 

SBN: 0761146199 

This article has been obtained from Articles2Go with 

permission to reprint by non-profit, or other user groups 

with credit given to the author, the publication and the 

user group. A copy of this newsletter has been sent to the 

author, or editor. 

* * * * *  

(Is This Thing On? - Review Continued from page 11) 

Smart Computing Magazine Tips 

Get Home Quickly:   

Whether you're searching a Web page, halfway through a long Word document, or checking out the latest 

numbers in an Excel sheet, in order to get to the very beginning of the information you're looking at, you can press 

CTRL-HOME.  

This will instantly return you to the start of any page without you scrolling your mouse or pressing an arrow key 

until you get to where you need to be. 

Hard-To-Read Web Pages 

Some Web sites and email messages are really hard to read. Whoever designed them may not have realized that 

some users have a hard time reading dark text on colored backgrounds.  

Here's a trick that can help. Select the text with a click and drag of your mouse. This usually highlights it in white 

on a blue background.  

If the text is still hard to read this way, copy and paste it into Notepad or some other black-on-white text editor. 

Reprinted with permission from Smart Computing. Visit www.SmartComputing.com/groups to learn what Smart 

Computing can do for you and your user group! 

http://www.abbyandme.com
http://www.SmartComputing.com/groups
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Digital Photography 

First Wednesdays 

MODERATOR, JERRY DINERMAN 

 

The SIG will resume its normal scheduling, starting 

with the January 5, 2011 session. 

* * * * * * * * * * * * 

Paint Shop Pro And Then Some 

Second Tuesdays 

MODERATOR, STAN GLAZER 

 

Stan always has something interesting at his sessions, 

sometimes he even goes over things from previous ses-

sions, in case you might have missed it. 

Join him and learn about digital liposuction, and other 

ways to improve the look of you photos, using Photo-

Shop 

* * * * * * * * * * * * 

Windows XP/Vista/Win7 SIG  

Second Thursdays 

MODERATOR, RICHARD MILLER 

 

Richard's SIG resumes its regular schedule Thursday, 

December 9, 2010. 

Hardware/Software 

Fourth Tuesday 

MODERATOR,  

"CAPTAIN RAY" SOLLBERGER  

 

Ray can not make it for the December session, nor can 

Larry Jablon, who capably assists Ray, so there will be 

no session in December. 

* * * * * * * * * * * * 

Freeware / Open Source 

Fourth Thursdays 

MODERATOR, STEVE COSTELLO 

 

The December 24, 2011 session, the night before 

Christmas Eve, will concentrate on where and how I find 

freeware. 

Files from the Freeware SIG sessions can be found in 

their own folders at: http://box.net/brcs-freewaresig.  

A BRCS Freeware SIG blog has been started, and is 

available at: http://brcsfreewaresig.blogspot.com/. Visit 

the blog often, and leave a comment on specific posts, as 

well as on the about page.  

Let me know what kind of freeware you are interested 

in, or let me know what you use in place of what I use, or 

problems you are having with freeware. 

* * * * * * * * * * * * 

SIG News 
This section is where you can find out information on what is happening in some of 
the Special Interest Groups (SIGs), currently running, as well as upcoming. 

Information provided here is from the SIG Moderators, and as such is not a 
complete listing, nor does it reflect everything happening in the SIGs. See the SIG 
listings and schedules in later pages of this newsletter, as well as checking http://
brcs.org regularly, for more information. 

http://box.net/brcs-freewaresig
http://brcsfreewaresig.blogspot.com
http://brcs.org
http://brcs.org
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BRCS Member’s Help Line 

This help line is for BRCS members who need answers 

to technical questions, but cannot wait for the monthly 

meetings. Help-line volunteers offer their time to assist 

BRCS Members only! 

Note: Some volunteers will answer questions only by 

email.  

If you would like to become a Help Line volunteer, 

contact: 

Help Line Coordinator Larry Jablon: 

Phone: (Noon to 10PM only) (561) 368-8028 

Email ljablon@juno.com. 

Digital Photography 

Jerry Dinerman ............................. gerald@dinerman.com 

Freeware 

Steve Costello (email only) ..................... editor@brcs.org 

General Computer Questions 

Larry Jablon ................................................ 561 368-8028 

 .................................................... Afternoon and Evenings 

Hardware 

Ray Sollberger ........................................... (561)487-2854 

HTML 

Jerry Bartzoff (email only) ........... jbartzoff@comcast.net 

Skype (Telephone via the Internet) 

Luis Sanchez .............................................. 561 483-6771 

Spanish Interpreter (Will relay questions) 

Luis Sanchez .............................................. 561 483-6771 

PLEASE REMEMBER: 

When you call the help-line, the people who answer are 

volunteers. please treat them courteously.  

Helpline contacts are not paid employees. They are 

fellow club members, who have volunteered to try to 

assist you. Please interact with them as such. 

PERSONAL ADS 

We are happy to run a personal ad, free of charge, 

and subject to space availability, for members of 

BRCS.  

Items must be computer related hardware or 

software.  

Send information, with a subject line beginning with 

the words BRCS Personal Ad, via email to: 

editor@brcs.org 

Computer Help At Your Home 
From a BRCS Member 

These club members make house calls. They have 

different skill levels, areas of expertise, and will 

charge different rates. 

The listing of any name does NOT constitute a 

recommendation by BRCS of the person providing 

the service. 

Call, or email, them for pricing, and to make 

appointments. 

Percy Alexander 561 483-4378 

Bob Dobski  561-265-0437 

Richard Miller  561-393-5813 

Lee Reynolds  954-755-8541 

Ray Sollberger  561-487-2854 

mailto:editor@brcs.org
mailto:editor@brcs.org
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Meeting / SIG Information 

Locations 

Patch Reef Park 

Exit I-95 at Yamato Road. Go West to second left turn 

after Military Trail (approximately 1/4 mile). Patch Reef 

Park is on the South side of Yamato Road. 

South County Civic Center 

On Jog Road, four or five blocks South of Linton Boule-

vard (opposite the Morikami Japanese Gardens). 

Sheriff’s Office,  

345 S. Congress Ave., Delray Beach.  

Please leave the last parking space open for the 

SIG leader.  

He/she has a lot of equipment to bring in for 

the class. It is impractical for the SIG Leader to 

carry it all from the general parking lot. 

Meetings 

Board Meeting 

2nd Monday, 7:00 p.m. at Patch Reef Park. 

General Membership Meeting 

3rd Wednesday, 7:30 p.m. at South County Civic  

Center. Q & A Tables start at 6:15 PM. 

Special Interest Group (SIG) Locations 

Paint Shop Pro And Then Some, Freeware / Open 

Source SIG , Hardware/Software, and Windows XP/

Vista/Win7 SIG  

Sheriff‟s Office, Room 219 

Advanced Mutual Fund Investing 

Sheriff‟s Office, Room 108 

Digital Photography  

Patch Reef Park  

Special Interest Groups 

Advanced Mutual Fund Investing 

Purpose: Advanced research of mutual funds market. 

Contact:  Gary Elsner 

GElsner@AnalyticFinancialSolutions.com 

Meets:  Fourth Tuesday, 7:00 PM 

Paint Shop Pro And Then Some 

Purpose: Discussions of Paint Shop Pro, and other 

digital image related items. 

Contact: Stan Glazer, glazer@brcs.org 

Meets: Second Tuesday, 7:00 PM 

Digital Photography - Rescheduled to December 8th 

Purpose: Discuss digital cameras, scanners, necessary 

software, hardware, and computers used in 

digital photography.  

Photo-editing, image organization, and 

photographic techniques are also discussed.  

Contact: Gerald Dinerman (561) 736-5601 

Meets:  First Wednesday, 1:30 PM  

Freeware / Open Source SIG  

Purpose: Discuss various freeware/open source 

applications and utilities, where to find them, 

and how to use them. 

Contact: Steve Costello, brcssteve+sig@gmail.com 

(954) 978-9010 

Meets:  Fourth Thursday, 7:00 PM 

Hardware/Software 

Purpose:  Focuses on computer hardware and associated 

software. 

Contact: Ray Sollberger (561) 487-2854 

Meets: Fourth Tuesday, 7:00 PM 

Windows XP/Vista/Win7 SIG  

Purpose: Review and learn to fine tune Windows XP, 

Vista, and Windows 7. 

Contact: Richard Miller (561) 393-5813 

Meets: Second Thursday, 7:00 PM 

mailto:brcssteve+sig@gmail.com
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Boca Bits Activities Calendars 

Be sure to check the BRCS website at  

http://www.brcs.org 

for locations, cancellations or changes, prior to the SIG or meeting you plan to attend. 

December 2010 

S M T W T F S 

   1 2 3 4 

5 6 7 8 9 10 11 

12 13 14 15 16 17 18 

19 20 21 22 23 24 25 

26 27 28 29 30 31  

       

DAY MEETING TIME 

Wed  8 Digital Photography SIG (Rescheduled) 1:30 PM 

Thu  9 Windows XP/Vista/Win7 SIG 7:00 PM 

Mon  13 Board Meeting 7:30 PM 

Tue  14 Paint Shop Pro And Then Some 7:00 PM 

Wed 15 Question & Answer Tables 6:15 PM 

  General Meeting 7:30 PM 

Sat 18 Boca Bits Submission Deadline 1:00 PM 

Thu  23 Freeware / Open Source SIG 7:00 PM 

Tue 28 Advanced Mutual Fund Investing SIG 7:00 PM 

  Hardware SIG (Cancelled for December) 7:00 PM 

January 2011 

S M T W T F S 

      1 

2 3 4 5 6 7 8 

9 10 11 12 13 14 15 

16 17 18 19 20 21 22 

23 24 25 26 27 28 29 

30 31      

DAY MEETING TIME 

Wed  5 Digital Photography SIG 1:30 PM 

Mon  10 Board Meeting 7:30 PM 

Tue  11 Paint Shop Pro And Then Some 7:00 PM 

Thu  13 Windows XP/Vista/Win7 SIG 7:00 PM 

Wed 19 Question & Answer Tables 6:15 PM 

  General Meeting 7:30 PM 

Sat 22 Boca Bits Submission Deadline 1:00 PM 

Tue 25 Advanced Mutual Fund Investing SIG 7:00 PM 

  Hardware SIG 7:00 PM 

Thu  27 Freeware / Open Source SIG 7:00 PM 

http://www.brcs.org
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For office use only 
Membership Number ______ Renewal Date___/___/___ Check No.______ Recommended By __________________ 

Member of 
The Florida 
Association of 
Computer User Groups 

 
Member of 

The Association of  
Personal Computer User Groups 

MEMBERSHIP APPLICATION 
Boca Raton Computer Society, Inc. 

5030 Champion Blvd., G-6 #202 
Boca Raton, FL 33496-2473 

Membership is $45.00 per year and includes the monthly Newsletter, 
Help Lines, attendance at SIG meetings, and more. 

First Name ______________________________ 
Address   _______________________________ 
City ____________________________________ 
State _______________  Zip ________________ 

Last Name ______________________________ 
Home Phone (     ) ________________________ 
Work Phone  (     ) ________________________ 
My Email Address _______________________ 

We depend upon volunteers to maintain the quality and efficiency of the organization. 

Your participation will not only help the club, but help you become more proficient on 

the computer. Please let us know your fields of interest. 

1.________________ 2.________________ 3.________________ 4._______________ 

 

Community Computer Clubs that you belong to: 

Alternate Address (for our Snowbirds) 
Do you want your newsletter, Boca Bits, mailed to another address for part of the year? If yes, complete the following: 

Address  _______________________________ 
City  ___________________________________ 
State _______________ Zip ________________ 

Home Phone (     ) _______________________ 
Dates: From __________ Through __________ 

mm/dd/yy mm/dd/yy 

www.facug.org
www.apcug.net


Boca Raton Computer Society, Inc 

5030 Champion Blvd., G-6 #202 

Boca Raton, FL 33496-2473 

About The Boca Raton Computer Society    
Since 1983, members of the PC User 
Group of Boca Raton, now the Boca Raton 
Computer Society, Inc., have been helping 
one another use and learn about computers.  

We have nearly 300 members, including 
computer professionals, business owners, 
home users, and novices.  

We welcome hundreds of visitors to our 
meetings each year. Network with others 
who share your interests! 

GENERAL MEETINGS 
(OPEN TO THE PUBLIC) 

General meetings are held on the third 
Wednesday of each month, at the South 
County Civic Center, 16700 Jog Road in 
Delray Beach, Florida.  

The Civic Center is on the east side of Jog 
Road, between Clint Moore Rd. and 
Linton Blvd., opposite Morikami Park. 

At 6:15 p.m. several QUESTION and 
ANSWER sessions are held to offer 
assistance to those seeking help with 
various computer topics. These sessions 
are staffed by club members.  

The formal meeting begins at 7:30 p.m., 
with most meetings featuring presentations 
by outside speakers including Microsoft, 
IBM, Adobe, Corel, etc.  

The Board of Directors meets on the 
second Monday of each month, at 7:00 
p.m., at Patch Reef Park on Yamato Road, 
just west of Military Trail, in Boca Raton. 
Members are welcome to attend. 

SERVICES 

BRCS members receive our monthly 
newsletter, Boca Bits, which provides 
information about meetings, SIGS, and 
includes articles by prominent writers, 
about current computer-related topics. 

Special Interest Groups (SIGs) are 
smaller meetings which explore specific 
topics in greater depth, such as Graphics, 
Hardware, Software, Windows, Scanners, 
email and Internet, to name a few. 

Although we support the sharing of Public-
domain and user-supported software, the 
BRCS strongly opposes illegal distribution 
of copyrighted software. 

From time to time, the BRCS arranges 
group purchase discounts on major 
hardware and software items. 

DUES (U.S. address only) 

Membership is $45 per year and includes 
the monthly newsletter, Help Lines, atten-
dance to SIG meetings and more.  

Dues may be paid at the general meetings 
or mailed to the address listed below.  

Visit the Boca Raton Computer Society‟s Web Page on the Internet 

http://www.brcs.org 

http://www.brcs.org

